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Everything you do in Windows 95 will be done using a
menu, dialog box or a window. This chapter shows you how
you can use these structures.
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Menus
Many of the windows will have a Menu bar near the top,
displaying the menu options relevant to a particular
window. Simply click on a menu option to reveal a drop-
down list of further options within it. As an example, we
will look at the View menu from the My Computer
window:

The ell ipse (i.e. ...) indicates that if

this option is selected, an

associated window with further

selections will be displayed,

A bullet also shows an option to be active

but only one option can be selected from a

group. Clicking another option from the

group will automatically turn off the

previously selected one.

To deactivate an option with a tick next to it, click on it.
Click on it again to activate it.

If an option is dimmed out, it cannot be used at that
particular time or is not appropriate.

Some options may have shortcut keys next to them so
you can use these instead of clicking on them with your
mouse.

A tick shows that an

option is active.

A forward arrow indicates

that there is another l inked

menu for selection. Move

the mouse arrow on the

option to see it.
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Dialog boxes
Although simple settings can be made quickly from menu
options, other settings need to be made from windows
displayed specifically for this purpose. These are called
dialog boxes.

Tabs - cl ick on the appropriate

one to display its settings.

Check boxes - cl ick on as many as

required. A tick indicates that an

option is active - if you click on it

again it will be turned off. If an

option is dimmed out, it cannot be

selected.

Radio buttons - only one out of a

group of radio buttons can be

selected - i f you click on another

radio button, the previously

selected one is automatically

turned off.

Action buttons - OKOKOKOKOK will save the

settings selected and close the

dialog box or window. CancelCancelCancelCancelCancel wil l

close the window without saving

the amended settings - click on it i f

you�ve made a mistake. ApplyApplyApplyApplyApply wil l

save the settings selected so far but

wil l not close the window, in case

you want to make further changes.
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Structure of a window
All windows are similar in their structure. You can have
a window containing icons for further selection, or a
window that displays a screen from a program.

Minimise Close

Menu bar

Title barControl

Scroll bar

Dialog
boxes are
usually
fixed size

windows and
therefore don't
have  scroll bars,
minimise, maximise,
restore buttons or
the control icon.
They also don't
display resize
pointers at the
edges.

icon

Double-click on an icon to open a window relating to it.

From the View menu, click on Toolbar to display further
buttons under the menu bar, or click on the Status Bar
option to display a bar under the bottom scroll bar - this
displays information about items selected from the
window.

The scroll bars will only appear when there are items that
cannot fit into the current size of the window.

If you move the mouse pointer over any edge of a window,
the pointer changes shape and becomes a double-headed
resize pointer - drag it to change the size of a window (see
page 26 - Resizing a window).

Maximise/Restore

Scroll arrow

Slider

Resize pointers
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Moving a window
As long as a window is not maximised occupying the whole
screen, you can move it. This is especially useful if you
have several windows open and need to organise your
desktop.

Move the mouse

pointer over the tit le

bar of a window.

1You can
also move
a window
by clicking

on the control icon
(top left) and then
using the four
directional cursor
arrow keys on the
keyboard move in
any direction.

Drag the

mouse pointer

to a new

location.

2 When the

window frame

is in the

desired

location,

release the

mouse button.

3If you have
installed
Microsoft
Plus, you

can have the Full
window drag
feature so that the
whole window
moves as you drag
the mouse, instead
of just the frame.
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Maximising, Minimising and
Restoring a window

A window can be maximised to fill the whole screen,
minimised to a button on the Taskbar, or restored to the
original size.

Restore buttonMinimise button

Maximise buttonMinimised window

Whether a window is maximised or original size, click on
the minimise button (left of the top-right three buttons) to
reduce the window to only a Task button on the Task bar.
This will create space on the desktop for you to work on
other windows. When you want to restore the reduced
window, simply click on it from the Task bar.

The middle button (out of the three) can either be a
maximise button, or if the window is already maximised
the same button changes to a restore button.

You can
also
double-
click on

the Title bar to
maximise the
window.

Click the
Control
icon (top
left) or

right-click the Task
button to display a
shortcut menu that
also allows you to
minimise, maximise
and restore the
window.

Maximised window
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Switching between windows
Switching between windows cannot be easier. The task
(window) that is active always has its Title bar highlighted.
If you have more than one window displayed on the
desktop, click anywhere inside a window that is not active
to activate it or switch to it.

If you have
too many
windows
open, Task

buttons will resize
themselves
automatically.

active windowactive task button

Another method of �task switching� is to use the Task bar at
the bottom. Every window that is open has a button created
automatically on the Task bar. Therefore, it does not matter
if the window you want to switch to is overlayed with others
and you cannot see it. Just click on the button for it in the
Task bar and the window will appear on top and it will be
active.

Press the
Alt+Tab
keys to
toggle and

switch between
tasks.
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Resizing a window
As long as a window is not maximised or minimised, it can
be resized.

Horizontal stretch

Diagonal stretch
Vertical stretch

Place the mouse arrow anywhere on the edge of a window

(including corners) - it wil l change to a double-headed resize

pointer.

1

Drag the pointer outwards to increase the size of the

window, or inwards to reduce the size.
2

When the outline is in the correct position, release the

mouse button - the window will now occupy the area

previously shown by the outline.

3

Resize and
move
windows
on your

desktop to the way
you prefer to work.



272. Basic Controls

Arranging windows
If you have several windows open on your desktop and want
to automatically rearrange them neatly, rather than resize
and move each one individually, use the cascade or tile
options from the Toolbar.

Right-click on the Task bar to display a shortcut menu.1
Click on Cascade (overlaps all the windows so that just the

Title bars are visible, except for the front one), Tile

Horizontally (resizes each window equally and displays them

across the screen in rows), or Tile Vertically (resizes each

window equally and displays them across the screen in

columns).

2

To avoid
cluttering
your
desktop,

try not to use the
Cascade and Tile
options - it is better
to use the Minimize
All Windows option
so if need to work
on any one, it is
only a mouse-click
away from the Task
bar.

Click on
Undo Tile
to restore
your own

arrangement of
windows before you
tiled them.
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Arranging icons
If you have icons displayed (large or small) in a window,
you can rearrange the order, either manually or
automatically.

Manually

Automatically

Drag an icon to

any space within a

window.

1

Click on the View

menu, and move

pointer over

Arrange Icons.

1

2 Click on an option

to neatly arrange

all the icons in a

preferred

sequence.

3 Click on Auto Arrange to activate it with a tick, so that if you

resize the window, the icons are rearranged automatically.

You can
drag an
icon out of
the

window and onto
the desktop or
another window.
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Scrolling
If a window is not big enough to display all the information
within it, then Scroll bars will appear automatically - either
vertical, horizontal, or both. Use these to see the contents
of a window not immediately in view.

Slider

Scroll arrow

Scroll bar

Drag the Slider along the Scroll bar towards one of the two

Scroll arrows to scroll in that direction.

or

Click on the Scroll bar to scroll just a l itt le towards the Scroll

arrow nearest to it.

or

Click on one of the Scroll arrows to scroll just a l itt le in that

direction. Hold down your mouse button to scroll

continuously.

1

The size of
the Slider
in relation
to the

Scroll bar indicates
how much of the
total contents are in
view. The position
tells you which
portion is in view.

2

3
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Closing a window
When you have finished with a window you will need to
close it. There are many ways of doing this - use the
method you find the easiest.

Click on the Close button

(top right corner).
1

If Minimised

Right cl ick on the Minimised

Task button.
1 Click on Close from the

shortcut menu.
2

From the Control icon

Click on the Control icon (top left corner).1

Click on Close from the

shortcut menu.
2

From the keyboard

Press Alt-F4 keys to close the active window.1

Save your
work
before
closing a

program window
that contains work
you�ve been doing.
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This chapter gets you started with CorelDRAW quickly.
We�ll look at some specialist CorelDRAW selection
techniques. Then you�ll learn how to create simple shapes.
Finally, you�ll also learn about shortcuts which allow you to
align the objects you create, easily and conveniently.
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Selection techniques
CorelDRAW makes use of standard Windows selection
procedures. For instance, with the Pick tool in the Toolbox
activated, clicking on a drawing object�s outline �selects� it
(this means that any editing actions you undertake apply
solely to this object). However, there are other selection
routes which are more or less specific to DRAW...

Using marquees
This is a very useful technique for selecting one or more
objects at a time. Make sure the Pick tool is activated.
Then simply move the mouse pointer to one corner of the
(imaginary) rectangle which contains the object(s) you
want to select. Click and hold down the left mouse button
as you drag out a dashed rectangle that completely
surrounds the objects. When you release the button, all
the enclosed objects are selected.

Using Shift
Another way to select several objects is to activate the Pick
tool and hold down one Shift key as you click sequentially
on the object outlines.

Selecting all objects automatically
You can have CorelDRAW select all objects on the current
page within the active document. To do this, pull down the
Edit menu and click Select All. Alternatively, double-click
the Pick tool.

Marquee

just before

the mouse

button is

released

If you hold
down one
Alt key as
you define

a marquee, objects
which merely
intersect it are also
selected.

Selected
objects are
surrounded
by eight

black rectangles �
see page 23.
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Working with selected objects
When you select an object in CorelDRAW, it�s surrounded
with black handles:

You can perform a variety of operations on selected
objects. These include:

• moving/resizing

• reshaping/rotation

• filling

• customising outlines

Moving and resizing are undertaken with more or less
standard Windows techniques (i.e. dragging a centre
handle stretches objects, thus disrupting their height/
width ratio, while dragging on a corner handle resizes
them proportionally). We�ll be looking at the use of
outlines, reshaping/rotation and fills in later chapters.

If you hold
down one
Ctrl key as
you resize

or stretch an object,
changes are made in
100% increments.

If you hold
down one
Shift key
as you

resize or stretch an
object, changes are
made from the
centre outwards.

A graphical object

in the course of

being resized

After the

mouse

button has

been

released;

the object

is selected

You can
combine
the above
keystroke

enhancements.



24 CorelDRAW in easy steps

Working with lines
Many drawing operations are undertaken with the help of
the Freehand or Bezier tools. These are accessible from
within the Toolbox. Follow the procedure below.

Click here (the wedge) to

launch the Curve flyout
1

2

3

Using the Freehand tool
The Freehand cursor is a cross with a wavy line. Click in
your drawing where you want the line to start. Then click
where you want it to end. If you want the line to continue,
click one line-end and draw another segment. Repeat this as
often as necessary.

Using the Bezier tool
The Bezier cursor is a cross with a circled wavy line. Click
where you want the line to start. Then click where you want
it to finish. If you want the line to continue, click where you
want the next line to end. Repeat this as often as necessary.
Press the Spacebar twice when you�ve finished (or activate
another tool by clicking on it in the Toolbox).

If you
define
additional
segments,

click as close to the
line-end as
possible.

If you hold
down the
Ctrl key as
you define

lines with the
Freehand tool,
they�re constrained
to 15 degree
increments.

A Bezier l ine

which has just

been created

Then click here to activate

the Bezier tool�

�or here to activate

the Freehand tool

See page
25 for how
to draw
curves

with the Freehand
tool.

The
Toolbox
looks
slightly

different in earlier
versions of
CorelDRAW.
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Working with freehand curves
Drawing freehand curves
Drawing freehand curves is one of CorelDRAW�s least user-
friendly operations, in the sense that using it effectively
requires some artistic ability. In fact, it�s probably the
feature you�ll use least of all. However, freehand drawing in
CorelDRAW can create highly original effects. Think of it
like using a pencil, or an Etch-a-Sketch.

To draw curves with the Freehand tool, launch the Curve
flyout (see page 24 for how to do this). Then select the
Freehand tool. Perform the following operations:

1. Place the mouse pointer where you want your curve to
start.

2 . Hold down the left mouse button.

3. Drag out the curves you need.

4. Release the mouse button when you�ve f inished.

Joining curves
If you want to create a new curve and join it to an existing
curve, place the mouse pointer over the endpoint of the
original. Then follow steps 2 to 4 above.

The illustration shows a typical CorelDRAW freehand curve:

You can
easily
erase part
of a

freehand curve
before you carry
out step 4. Simply
hold down one Shift
key while you drag
backwards over
your curve. Release
Shift to resume
drawing.

If you
define
additional
curves,

click as close to the
endpoint as
possible.
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Working with ellipses

You can
create an
ellipse
from the

centre outwards.
Simply hold down
one Shift key as you
carry out steps 2-4.

Or press F7. Now carry out these steps:

1 . Place the mouse pointer at the location where you want
one corner of the ell ipse to begin.

2. Click and hold down the left mouse button.

3. Drag to create the ell ipse.

4. Release the mouse button.

The following is an example of a CorelDRAW ellipse.

Click here

CorelDRAW makes creating ellipses easy.

Drawing an ellipse
In the Toolbox, click on the Ellipse tool.The

Toolbox
looks
slightly

different in earlier
versions of
CorelDRAW.
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Working with circles
CorelDRAW lets you create perfect circles very easily, with
the minimum of expertise. You can also create circles
outwards, from the centre.

Drawing circles
In the Toolbox, click the Ellipse tool. (For how to do this,
see page 26.)

Alternatively, press F7, a useful keyboard shortcut which
activates the Ellipse tool automatically.

Now carry out these steps:

1. Place the mouse pointer at the location where you want
one corner of the circle to begin.

2. Hold down one Ctrl key.

3. Click and hold down the left mouse button.

4. Drag to create the circle.

5. Release the mouse button.

The following is an example of a CorelDRAW circle:

Make sure
you
release the
Ctrl key

after you�ve
released the left
mouse button.

To create a
circle from
the centre
outwards,

simply hold down
one Shift key (as
well as Ctrl) as you
carry out steps 2-4.
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Working with rectangles
You can easily create rectangles in CorelDRAW.

Drawing a rectangle
In the Toolbox, click on the Rectangle tool.

Or press F6. Now carry out these steps:

1. Place the mouse pointer where you want one corner of

the rectangle to begin.

2. Click and hold down the left mouse button.

3. Drag to create the rectangle.

4. Release the mouse button.

Click here

You can
create a
rectangle
from the

centre outwards.
Simply hold down
one Shift key as you
carry out steps 2-4.

A sample

CorelDRAW

rectangle

The
Toolbox
looks
slightly

different in earlier
versions of
CorelDRAW.
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Working with squares
In the same way that the use of the Ellipse tool can be
extended to produce perfect circles, the Rectangle tool can
produce squares.

Drawing a square
In the Toolbox, click on the Rectangle tool. For how to do
this, see page 28.

Alternatively, press F6.

Now carry out these steps:

Make sure
you release
the Ctrl
key after

you�ve released the
left mouse button.

1. Place the mouse pointer at the location where you want

one corner of the square to begin.

2. Hold down one Ctrl key.

3. Click and hold down the left mouse button.

4. Drag to create the square.

5. Release the mouse button.

The following is an example of a CorelDRAW square.

You can
create a
square
from the

centre outwards.
Simply hold down
one Shift key (as
well as Ctrl) as you
carry out steps 2-5.
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Using grids
CorelDRAW provides several aids which allow you to align
objects you create automatically and precisely (this is also
useful when you resize objects). One of the foremost of
these is grids.

Grids consist of a uniform arrangement of points to which
objects can be �snapped� i.e. aligned automatically.

Setting up a grid
Pull down the Layout menu and click Grid and Ruler Setup.
Then carry out the following:

A

magnif ied

view of

some grid

points

Type in the number

of points you need

Click the Grid tab1

2

Click OK5

Click here to have

the grid display
3

4 Click here to have objects al ign to the grid

Click
Frequency
before you
carry out

steps 2-5.

The
Spacing
field is
missing

from this dialog in
earlier versions of
CorelDRAW.
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Using the ruler
Rulers are another aid to aligning objects. Both horizontal
and vertical rulers are flexible, on-screen calibrations which
you can use to size and position drawing components.

Repositioned

ruler (see

tip)

Displaying the rulers
If the rulers aren�t currently displaying, pull down the View
menu and choose Rulers.

Specifying ruler settings
Double-click on an existing ruler. Now perform the
appropriate action, as follows.

(Optional) Enter

new values here

to reset the ruler

origin point

Click here

Click the Ruler tab1

3

4

You can
move
rulers onto
the page

itself. To do this,
move the mouse
pointer over a ruler.
Hold down one Shift
key; left-click and
drag it to the
required location.

2 (Optional) Click the arrows

and choose new ruler units

This is a
ruler in its
standard
position:



32 CorelDRAW in easy steps

Using guidelines
Whereas grids can be used to position all the objects within
a particular drawing, you use guidelines to position
individual objects. Guidelines are movable, non-printing
lines on screen. You can create as many guidelines as you
need.

Creating a horizontal guideline
Move the mouse pointer over the horizontal ruler. Click
and hold down the left mouse button. Drag onto the page.
Release the button when the guideline is correctly
positioned.

Creating a vertical guideline
Move the mouse pointer over the vertical ruler. Click and
hold down the left mouse button. Drag onto the page.
Release the button when the guideline is correctly
positioned.

Guidelines
are saved
with the
document

which contains
them.

Horizontal ruler

Vertical ruler

Vertical

guideline

Horizontal

guideline

To make
objects
align to
guidelines

(when you create or
reposition them),
pull down the
Layout menu and
click Snap To
Guidelines.
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Creating a slanting guideline
A feature which is currently lacking in just about any other
program is the ability to define sloping guidelines. These
are useful for positioning objects whose shape is
nonstandard.

To create a slanted guideline, first create a vertical or
horizontal guideline (see �Creating a horizontal guideline�
and �Creating a vertical guideline�, on page 32). Then move
the mouse pointer (it changes to a curving, two-headed
arrow) over one of the guideline handles. Click and drag it
until the angle is correct. Then release the mouse button.

Remember
that once
you�ve
slanted a

guideline, you can
only convert it back
again if you�re using
version 7.

Moving guidelines
You can easily reposition guidelines you�ve already created.
To do this, move the mouse pointer over the guideline.
Click and hold down the left mouse button; drag the
guideline to its new location. Release the mouse button to
confirm the move.

Deleting horizontal/vertical guidelines
Place the mouse pointer over the guideline you want to
remove. Click and hold down the left mouse button; drag
the guideline back to the horizontal or vertical ruler (it
doesn�t matter which). Release the mouse button to confirm
the deletion.

Magnif ied

views of

guideline

handles

To delete a
slanting
guideline,
double-

click it. In the
Guidelines Setup
dialog, click the
Slanted tab. Select
the guideline in the
box and click Delete.
Click OK.

Note: version 7
users can use this
method:

Slanting
guidelines
were a new
feature in

version 6 of
CorelDRAW.

Guideline
handles
are shown
slightly

differently in earlier
versions of DRAW.

�contd
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Snapping to objects
There is one final technique you can use to align your
drawings. When you create or reposition an object, you can
have it snap automatically to (i.e. align with) another. This is
possible because the various types of objects you work with
in CorelDRAW (e.g. lines, curves, ellipses/circles,
rectangles/squares, text, bitmaps) are allocated several
convenient �snap points� when created. These are usually
located at the centre and perimeter.

Turning on Snap to Objects
To have objects you create or change snap to existing
objects, pull down the Layout menu and click Snap To
Objects.

Viewing snap points
To see an object�s snap points, first make sure Snap to
Objects is enabled. Then launch the Curve flyout (see page
24 for how to do this) and do the following:

DRAW
operates a
snap
hierarchy.

Snap To Objects
takes precedence
over Snap To Grid or
Snap To Guidelines.

Activating
DRAW�s
Snap To
Objects

feature has no
effect on the
alignment of
existing objects.

Click here

Now move the mouse pointer over the object. CorelDRAW
reveals snap points when the pointer encounters them.

Rectangular

snap point

and cursor



Contents of
Office 97 in Easy Steps

1. A Common Approach
Introduction
Toolbars
Creating new documents
Launching the New dialog
Using the New dialog
Working with templates
Working with Wizards
Opening Office documents
Opening Internet documents
Saving Office documents
Saving to the Internet
Publishing to the Internet
Using Office's HELP system
The Office Assistant
The Shortcut bar - an
overview
Displaying Shortcut bar
toolbars
Specifying the Shortcut bar
location
Auto-hiding the Shortcut bar
Adding buttons to the
Shortcut bar

2. Word
The Word screen
Entering text
Sending e-mail
Moving around in documents
Using views
Changing zoom levels
Formatting text - an overview
Changing the font or type
size
Changing text colour
Changing the font style
Font effects
Indenting paragraphs - an
overview
Applying indents to
paragraphs
Aligning paragraphs
Specifying paragraph spacing
Line spacing - an overview
Adjusting line spacing
Paragraph borders
Paragraph fills
Working with tabs
Searching for text

Replacing text
Working with headers
Working with footers
Undo and redo
Text styles - an overview
Creating a text style
Applying a text style
Amending a text style
Spell- and grammar-checking
Searching for synonyms
Working with pictures
Brief notes on picture formats
Inserting pictures
Editing pictures
Rescaling pictures
Bordering pictures
Cropping pictures
Page setup - an overview
Specifying margins
Specifying the page size
Using Print Preview
Zooming in or out in Print
Preview
Multiple pages in Print
Preview
Clearing the screen in Print
Preview
Printer setup
Printing - an overview
Printing - the fast track
approach
Customising printing

3. Excel
The Excel screen
Entering data
Modifying existing data
Working with cell ranges
Moving around in worksheets
Other operations on
worksheets
Selection techniques
Formulas - an overview
Inserting a formula
Inserting a function
Amending row/column sizes
Inserting cells, rows or
columns
AutoFill
Changing number formats

Changing fonts and styles
Cell alignment
Bordering cells
Shading cells
AutoFormat
Find operations
Find-and-replace operations
Charting - an overview
Creating a chart
Working with pictures
Page setup - an overview
Setting page options
Setting margin options
Setting header/footer options
Setting sheet options
Page setup for charts
Launching Print Preview
Working with Print Preview
Printing worksheet data
Printing - the fast track
approach

4. PowerPoint
The PowerPoint screen
The AutoContent Wizard
The slide views - an overview
Using the slide views
Customising slide structure
Adding text to slides
Formatting text
Moving through
presentations
Inserting and deleting slides
Inserting pictures
Printing
Running a presentation

5. Outlook
The Outlook screen
Using the Outlook bar
Working with the calendar
Working with the Tasks
folder
Working with the Contacts
folder
Selecting an information
service
Sending/receiving e-mail

Index



This chapter shows you how Office provides a common
look, so you can get started quickly in any module. You�ll
learn how to create new documents and open/save existing
ones (on your hard disk, and on the Internet). You�ll learn
how to use the Shortcut bar to save time and energy, and
also how to get information you need from Office�s on-line
HELP system (including the Office Assistant).

Covers

Introduction ................................................................................... 8

Toolbars ............................................................................................ 9

New documents ........................................................................... 10

Working with templates.......................................................... 14

Working with Wizards ............................................................... 15

Opening Office documents ..................................................... 16

Opening Internet documents ................................................. 17

Saving Office documents ........................................................ 18

Saving to the Internet ............................................................. 19

Publishing to the Internet ..................................................... 20

Using Office�s HELP system ................................................... 21

The Office Assistant ................................................................. 22

The Shortcut bar ......................................................................... 26

A Common Approach
SE

C
TI

O
N

 O
N

E



8 Office 97 in easy steps

There are,
of course,
differences
between

the module screens;
we�ll explore these
in later sections.

Introduction
The Standard edition of Microsoft Office consists of four
modules:

• Word � word-processor

• Excel � spreadsheet

• PowerPoint � presentation/slide show creator

• Outlook � personal/business information manager

Three at least of these programs are leaders in their
respective fields. The point about Office, however, is that it
integrates the four modules exceptionally well. With the
exception of Outlook, which necessarily adopts a relatively
individualistic approach, the modules share a common look
and feel.

The illustration below shows the Word opening screen.
Flagged are components which are common to PowerPoint,
Outlook and Excel, too.

Office Assistant

Toolbars

Scroll

bars

Menu barTitle bar

Outlook �
because of
its very
nature - is

slightly different.
For instance, it has
only two toolbars.

For more
information
on the use
of the

Office Assistant,
see pages 22-25.
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Toolbars are important components in all four Office
modules. A toolbar is an on-screen bar which contains
shortcut buttons. These symbolise and allow easy access to
often-used commands which would normally have to be
invoked via one or more menus.

For example, Word�s Standard toolbar lets you:

• create, open, save and print documents

• perform copy & paste and cut & paste operations

• undo editing actions

• access Word�s HELP system

by simply clicking on the relevant button.

Toolbars vary to some extent from module to module. We�ll
be looking at these in more detail as we encounter them. For
the moment, some general advice.

Specifying which toolbars are displayed
In any Office module, pull down the View menu and click
Toolbars. Now do the following:

Toolbars

1 Click the toolbar you

want to be visible � a 4

appears against it

This is
Excel�s
toolbar
list.

Available toolbars
in Word,
PowerPoint and
Excel vary slightly.

Repeat this procedure for as many toolbars as necessary

To add a
new
button to
a toolbar

(but not in
Outlook), right-click
over the toolbar.
Click Customize. In
the dialog which
launches, click the
Commands tab. In
the Categories field,
click a category (a
group of associated
icons). In the
Commands box, drag
a button onto the
toolbar in the open
document. Finally,
click Close.

Outlook
has only
two
available

toolbars.
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Creating new documents
With the exception of Outlook (see Section 5), all Office
modules let you:

• create new blank documents

• create new documents based on a �template�

• create new documents with the help of a �Wizard�

Creating blank documents is the simplest route to new
document creation; use this if you want to define the
document components yourself from scratch. This is often
not the most efficient or effective way to create new
documents.

Templates � also known as boilerplates � are sample
documents complete with the relevant formatting and/or
text. By basing a new document on a template, you
automatically have access to these.

Wizards are advanced templates which incorporate a
question-and-answer system. You work through a series of
dialogs, answering the appropriate questions and making the
relevant choices.

Documents created with the use of templates or Wizards can
easily be amended subsequently.

Both templates and Wizards are high-powered yet easy to
use shortcuts to document creation. Office provides a large
number of templates and Wizards. For example, Word
offers Wizards which automate the production of
newsletters, faxes, letters and memos, as well as numerous
templates.

All three document creation methods involve launching the
New dialog. This can be accessed:

• by using the Office Shortcut bar

• from within the modified Windows 95 Start menu

• from within the relevant Office program

The topics
that relate
to the New
dialog,

templates and
Wizards do not
apply to Outlook.

Because
Word,
PowerPoint
and Excel

are uniform in the
way they create new
documents, we�ll
look at this topic
here rather than in
the later sections,
which are specific to
each program.
(However, see
Section 4 for
specialised advice on
creating new slide
shows.)
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Launching the New dialog

Click here

Utilise any of the following methods:

Using the Shortcut bar
Within the Office Shortcut bar, do the following:

Using the Start menu
When Office is installed, it amends the Windows 95 Start
menu. Carry out the following procedure:

2 Click here

1 Click here

From within the program
In Word, Excel or PowerPoint, pull down the File menu and
do the following.

The
following
keyboard
shortcut is

available in Word,
PowerPoint and
Excel. Simply press
Ctrl+N. Click here

If the
Office
toolbar
isn�t

uppermost in the
Shortcut bar, right-
click on the bar.
Click Office in the
menu that appears.
(For more help with
the Shortcut bar,
see later topics.)
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Using the New dialog

Activate the relevant tab1

The form the New dialog takes depends, to some extent, on
which method you use to launch it. If you invoke it by using
the Shortcut bar or the Start menu, you get the full version
which incorporates elements from Word, Excel and
PowerPoint. You can then choose which type of new
document you want to create.

If, on the other hand, you launch it from within the relevant
program, you get a specific, abbreviated form.

Using the full New dialog
First launch the New dialog (see page 11 for how to do this).
Then do the following:

Click the blank

document, template or

Wizard you want to use

2 Click here

In the above illustration, a new blank PowerPoint
presentation is being created.

To create a
blank
document,
activate

the General tab and
click the Blank
Document (Word),
Blank Workbook
(Excel) or Blank
Presentation
(PowerPoint) icon.

The
Preview
section on
the right

provides an
illustration of what
your new document
will look like
(providing it�s based
on a template or
Wizard).

3
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Using the program-specific New dialog
First launch the New dialog (see page 11). Then do the
following:

Activate the relevant tab1

Click the blank document, template

or Wizard you want to use
2

3 Click

here

In the above illustration, a new Word document is being
created, based on the Wizard LETTER WIZARD.WIZ.

Notice that the only new document options you can access in
this form of the New dialog are Word-specific.

...contd

A letter

produced

by Word�s

Letter

Wizard
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Working with templates
If you elected to base your new document on a template,
Office creates a detailed document complete with preset text
and formatting.

The illustration below shows a new Excel worksheet based
on the template INVOICE.XLT.

Fields

Feature buttonFloating toolbar

Feature button

This provides a good idea of how useful and sophisticated
Office�s templates are. In this case, Office has:

• created numerous pre-defined fields

• created several additional worksheets

• formatted the worksheet

• inserted special buttons which you can click to launch
features directly

• launched a dedicated (�floating�) toolbar

Amend these as you see fit, then save the template as a
document in its own right.
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Working with Wizards
When you elect to create a new document with the help of a
Wizard, Office launches a succession of dialogs. The
illustration below is the first dialog when you run the Word
Fax Wizard.

Whichever Wizard you use, in whichever Office module
(apart from Outlook), complete the necessary fields and/or
click the necessary options. Then click Next to move on to
the next dialog. Continue doing this until you reach the final
dialog. Then do the following:

Office tells
you when
you�ve
reached

the final dialog by
dimming the Next
button.

Click here

The end result of using a Wizard is the same as using a
template: a feature-rich document which you can amend as
necessary.

Complete the

dialog (if

appropriate)

Then click

here

You can�t
use
Wizards
within

Outlook.

See the
�Publishing
to the
Internet�

topic later for how
to use the Web
Page Wizard in
Word.
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5

Click here. In the drop-down list, cl ick the

drive that hosts the document

Click the fi leMake sure the correct f i le

type (e.g. �Microsoft Excel

Files�) is shown. If it isn�t,

cl ick the arrow.

1

Click

here

3

6

I f the

fi le is in

a

folder,

double-

click it

4

We saw earlier that Office lets you create new documents
in various ways. You can also open Word, Excel and
PowerPoint documents you�ve already created.

In any module apart from Outlook, pull down the File
menu and click Open.

Opening Office documents

For how to
open an
existing
schedule or

contact/task list in
Outlook, see
Section 5.

Click a f i le type2
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In any of the Office modules (apart from Outlook), you can
open documents stored at any HTTP site on the World Wide
Web.

If the Web toolbar isn�t currently on-screen, move the mouse
pointer over any existing toolbar and right-click. In the
menu which appears, click Web. Now do the following:

Opening Internet documents
To open
Internet
documents,
you must

have access to the
Internet (e.g. via a
service provider),
and you must have
installed a modem.
Additionally, your
connection must be
open when you
carry out the
procedures listed
here. (For more
information on the
Internet in general,
read a companion
volume: �Internet
UK in easy steps� by
Andy Holyer.)

2 Click here

1 Click here

3 Type in a Web address 4 Click here

If you
don�t know
the site
address,

don�t follow step 3.
Instead, click
Browse. Use the
Browse dialog (a
variant of the Open
dialog discussed on
page 16) to locate it.
Click Open. Then
follow step 4.
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Saving Office documents
It�s important to save your work at frequent intervals, in
order to avoid data loss in the event of a hardware fault or
power interruption. With the exception of Outlook, Office
uses a consistent approach to saving.

Saving a document for the first time
In Word, Excel or PowerPoint, pull down the File menu and
click Save. Or press Ctrl+S. Now do the following:

Click here. In the drop-down list, cl ick the

drive you want to host the document

1 Click here. In the l ist,

cl ick the format you

want to save to

5

3 Double-click

the folder

where you

want to save

the fi le

Click here

Saving previously saved documents
In Word, Excel or PowerPoint, pull down the File menu and
click Save. Or press Ctrl+S. No dialog launches; instead,
Office saves the latest version of your document to disk,
overwriting the previous version.

This is Word�s Standard toolbar

A shortcut
you can
use for
either save

method: in Word/
Excel/PowerPoint,
click here:

2

Type in a f i le

name
4
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Saving to the Internet
In any of the Office modules (apart from Outlook), you can
save documents to any HTTP site on the World Wide Web.
This is a two-stage process:

1 . saving your completed Office document in HTML
(HyperText Markup Language) format

2 . copying the HTML files to your service provider

Step 2 is outside the scope of this book.

Pull down the File menu and click Save as HTML. What
happens now differs from module to module.

Word
Word launches the Save As HTML dialog. Complete this as
per steps 2-5 on page 18. After step 5, Word reopens the
document in HTML format. Note that some of the
formatting may have disappeared or have been changed �
the Web supports fewer formatting variables.

PowerPoint and Excel
These modules launch a special Wizard (different in each).
Do the following:

Re. step 2
� to
publish
your Office

documents on the
Web, you must have
access to the
Internet (e.g. via a
service provider),
and you must have
installed a modem.
For help with step 2,
consult your service
provider. For more
information on the
Internet in general,
read a companion
volume: �Internet
UK in easy steps� by
Andy Holyer.

Complete the

dialog (if

appropriate)

Then click

here

Now complete the additional Wizard dialogs which appear.
Finally, do the following:

Click here

You can
use the
Web
toolbar (in

any module) to
browse through or
open any Web
documents. For
example:
click ß to move
backwards, à to
move forwards. Click
Favorites, Add to
Favorites to add the
current Web page to
your list of often
used sites . . .
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Publishing to the Internet
On page 19, we discussed how to save an existing Office
document in HTML format (for future transmission to the
Web). However, in Word you can also use another method to
produce documents on the Web. You can run the Web Page
Wizard to create a new Web document from scratch. (After
it�s complete, you must still copy the relevant HTML files to
your service provider � see the tip on the left).

Pull down the File menu and click New. Now do the
following:

To publish
your
completed
Word

document on the
Web, you must have
access to the
Internet (e.g. via a
service provider),
and you must have
installed a modem.

You can
also create
slide shows
directly for

the Web from
within PowerPoint,
though with the use
of templates rather
than a Wizard. Pull
down the File menu
and click New. In
the New
Presentation dialog,
click the
Presentations or
Web Pages tabs.
Double-click an
appropriate
template. Now
amend the template
(as appropriate) and
save it, then send
the completed files
to your service
provider.

1 Click here

2 Double-click

here

3 Click a layout

4 Click here

Now complete the next dialog, then click the Finish button.
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Using Office�s HELP system
Office supports the standard Windows 95 HELP system. For
instance:

• moving the mouse pointer over toolbar buttons
produces an explanatory HELP bubble:

• moving the mouse pointer over fields in dialogs,
commands or screen areas and right-clicking produces
a specific help box. Carry out the following procedure
to activate this.

Left-click here for the specif ic

help topic

Other standard Windows 95 HELP features are also present;
see your Windows documentation for how to use these.
Additionally, all the Office applications have inbuilt HELP in
the normal way . . .

Office also has one unique HELP feature: the Office
Assistant. See the next topic.

Office calls
these
highly
specific

HELP topics
�ScreenTips�.

Office calls
these
highly
specific

HELP bubbles
�ToolTips�. ToolTips
are a specialised
form of ScreenTips
(see below).
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The Office Assistant (1)
Office has a unique HELP feature, designed to make it much
easier to become productive: the Office Assistant. The Office
Assistant:

• answers questions directly. This is an especially useful
feature for the reason that, normally when you invoke a
program�s HELP system, you know more or less the
question you want to ask, or the topic on which you
need information. If neither of these is true, however,
Office Assistant responds to Plain English questions
and provides a choice of answers. For example,
responses produced by entering �What are ToolTips?�
include:

� Show or hide shortcut keys in ToolTips

� Show or hide toolbar ScreenTips

� Turn ScreenTips off

• provides context-sensitive tips

• offers HELP which relates to the Office module being
used

The Word Off ice

Assistant, after it has just

launched

The Office
Assistant
is
animated.

It can also can
change shape! To do
this, click the
Options button:
In the dialog which
appears, activate
the Gallery tab.
Click the Next
button until the
Assistant you want
is displayed. Then
click OK.

If the
Assistant
HELP
bubble

isn�t displayed,
simply click
anywhere in the
Assistant.
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Click here

Launching the Office Assistant
By default, the Office Assistant displays automatically. If it
isn�t currently on-screen, however, refer to the on-screen
toolbar and do the following:

The Office Assistant (2)

Displaying tips
Ensure the Office Assistant is on-screen. Then do the
following:

Click here

A context-sensitive tip appears. Do the following when
you�ve finished with it:

Click here

Click Next
or Back (if
available)
to view

another tip:
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The Office Assistant (3)
Spontaneous tips
Sometimes, the Office Assistant itself will indicate that it
has a tip which may be useful:

Click here to view a suggested tip

If the
Office
Assistant
isn�t on-

screen when a tip is
launched, the
toolbar button
which launches it
changes to:

Hiding the Office Assistant
If you don�t want the Office Assistant to display, right-click
over it and do the following:

The bulb indicates

a latent tip

Click here
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The Office Assistant (4)
Previously, Office had a feature called the Answer Wizard.
This allowed you to enter questions in Plain English. The
advantage of using the Answer Wizard was that you could
use it to find information on topics which you weren�t sure
how to classify.

The Office Assistant incorporates an improved version of
the Answer Wizard.

Asking questions
First, ensure the Office Assistant is visible. Then do the
following:

1 Type in your

question

2 Click here

3 Click an option

Re. step 3
� if none of
the topics
are

suitable, click See
More. Then click the
correct option in the
new list.

To close
an Office
Assistant
window at

any time, press Esc.
Or click the Close
button:
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As its name implies, the main function of the Windows 95
Taskbar is to switch between already open applications.
Beyond this, it has some deficits. For instance, it doesn�t let
you start programs directly with a single click on a button
(instead, you have to use the normal Start menu route,
which requires several clicks and/or mouse movements).
The Office Shortcut bar rectifies this omission. You can add
buttons for any programs you want, and start them very
quickly and easily.

The Shortcut bar also mimics the Taskbar. If a program is
already open, clicking on its button on the Shortcut bar
switches to it.

You can determine the Shortcut bar�s on-screen location.
Additionally, you can have it display permanently, or �auto-
hide� it (where it only appears on screen when you move the
mouse pointer to a specific screen area, or hot spot).

Toolbars
Buttons on the Shortcut bar are organised into specialist
toolbars . The main toolbars are:

Office has buttons relating specifically to Office
modules

Programs by default, has buttons representing
program folders

Desktop has buttons representing folders on your
desktop (e.g. My Computer, Inbox, My
Briefcase)

Accessories has buttons representing programs
normally accessed from the Start/
Accessories menu (e.g. Notepad, WordPad,
CardFile and Paint)

You can display as many, or as few, toolbars as you want.

The Shortcut bar - an overview

This only
works with
Office
programs;

if you try it with
other programs, a
second copy of the
application
launches.
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Displaying Shortcut bar toolbars
Office uses a unique effect when you have more than one
toolbar displayed at once on the Shortcut bar: it layers them.

Look at the illustration below:

Active toolbar

To make another toolbar active, simply left-click on it.

Hiding/revealing toolbars
Move the mouse pointer over any toolbar and right-click
once. Now do the following:

Click any toolbar to select

or deselect it � a 4

appears against its entry

Repeat this procedure for however many toolbars you want
to hide or reveal.

Here, the
Shortcut
bar is
�floating�;

for how to display it
on the top, bottom,
left or right of your
screen, see the
�Specifying the
Shortcut bar
location� topic next.

Layered toolbars
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Specifying the Shortcut bar location
You can have the Shortcut bar display on the left or right, or
on the top or bottom of your screen. Alternatively, you can
have it �float� on screen, as a separate window.

Use whichever method is most convenient for the task in
hand.

To move the Shortcut bar to the top, bottom, left or right of
your screen (Office calls this �docking�), move the mouse
pointer anywhere over the Shortcut bar (but not over one of
the buttons). Hold down the left mouse button and drag the
bar to the appropriate screen area. When you release the
mouse button, the bar �docks� automatically.

This illustration shows the Shortcut bar when positioned at
the top of the screen:

Double-
click the
title bar to
have the

Shortcut bar jump
back to the last
occupied position.

Shortcut buttons

Layered toolbars

Title bar

The Shortcut bar

posit ioned

horizontally, over

ExcelThis is
another
Office
Assistant �

see page 22 for how
to use additional
Assistants.
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When it�s floating, the Shortcut bar behaves much like any
other window. For example, if it�s minimised, clicking on
the Shortcut bar button on the Taskbar maximises it. (For
more information on how to interact with the Shortcut bar
when it�s floating, see your Windows documentation).

If it�s docked, on the other hand, the Shortcut bar can be
made to conceal itself bashfully when not required. To do
this, double-click in the Shortcut bar (but not on a button, or
in the Title bar). Now do the following:

You can
only auto-
hide the
Shortcut

bar if it�s docked,
not if it�s floating.

You can
use a
shortcut to
auto-hide

the Shortcut bar.
Right-click over the
bar; in the menu
which appears, click
Auto Hide. This
procedure also
revokes auto-hide,
if required.

Auto-hiding the Shortcut bar

3

Ensure this

is ticked

Click here

Ensure the View tab is active1

Making the Shortcut bar reappear temporarily
To make the Shortcut bar visible again when you need it,
simply move the mouse pointer to the edge of the screen
where the Office Shortcut Bar is docked. For instance, if the
bar was docked on the bottom of the screen, move the
pointer as far down as it will go.

When you�ve finished, move the mouse pointer away from
the docking area; the Shortcut bar disappears again.

2
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Adding buttons to the Shortcut bar
You can add buttons that represent files to the Shortcut bar.
These files can be program files, or just about any other
kind of file.

Double-click in the Shortcut bar (but not on a button, or in
the Title bar). Now do the following:

5

If the fi le is

in a folder

(prefixed

by ) ,

double-

click it

3
Click here

Click here. In the drop-down list, cl ick the

drive which hosts the fi le

Click the fi le

7 Click here

Ensure the Buttons tab is active1

6

4

Click

here
2
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Overview
Let�s get the boring technical bit out of the way first:
HTML is a Data Type Descriptor (DTD) of Standard
Generalised Mark-Up Language (SGML). SGML is an
international standard which describes how to take text
stored on computer, and mark it up to add extra
information, in the same way as a proof reader used to
mark up a printed page. SGML is the basic scheme for all
kinds of mark-up that anyone could possibly want. A DTD
specifies the exact types of mark-up that should be used for
a particular purpose. In case you�re interested, other SGML
DTDs allow text to be marked up to allow computerised
translation (so that words can be tagged as a noun or a
verb, for example), or to annotate a text (like the editions of
Shakespeare which have a glossary, for instance). Now you
know what a DTD is. Now you can forget it again.

Because of the success of the World-Wide Web, the
commonest SGML DTD is HyperText Markup Language,
which is the reason we�re here.

The core of any HTML document is just text. The text is
marked up using HTML tags. Tags look like this:

<H1>This is a Heading</H1>

Start tag Text End tag

All HTML tags come between a �<� and a �>�. Most tags
affect an area of text, and come in pairs. If a start tag is
�<TAG>�, the end tag will be �</TAG>�. All the mark-up
information you provide to the browser comes from some
type of tag.

Some types of tag need extra information. For example, an
IMG tag (which produces an inline image) needs the
filename of the image, and possibly information about the
size of the image and how the browser should align the
image with respect to the surrounding text. This

Tags can
be in either
upper or
lower case

(or even in mixed
case). I tend to write
tags in capitals,
since it makes them
easier to spot.
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information is called the tag�s �attributes�. Only start tags
have attributes � they�re meaningless in an end tag.
Attributes look like this:

<IMG SRC="andy.gif">

This

identif ies

the type of

tag. In this

case, an

image tag

This is the

attribute name.

The �SRC�

attribute is short

for �source� and

gives the location

of the image fi le

This is the attribute

value. It means that

the �.GIF� fi le �andy.gif�

wil l be placed in the

document here.

Some types of tags need a number of attributes. That�s
easy: just put one or more spaces (or tabs, or new lines)
between each attribute-value pair. Attribute names, like
tags, can be written in either capitals or lower case (or in a
mixture of both, if you really want to). Most attribute values
are case-sensitive (that is, if your file is called �andy.gif�
and you write �Andy.gif� in your HTML file, it won�t work).
You don�t always have to put attribute values in quotes, but
it can be a good idea. If the value has spaces in it then you
do have to use quotes.

An important thing to remember when you�re producing
HTML is that it only specifies the semantics of the page:
the actual layout is up to the browser � for example, what
font is used for display, or what font size to use. You can
get round this to a degree by using style sheets (on some
browsers, at least), but generally you should not rely on
your page looking exactly like it does on your computer.
We�ll come back to this concept later on.

�Semantics�
means
what the
page

actually means,
rather than what it
physically looks
like.

�contd
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Versions of HTML

You can
always
find the
latest

definition of the
HTML standard
(and other useful
information) on the
W3 web site at
http://www.w3.org.

HTML was originally designed as a small, simple set of
tags which could be learned in an afternoon and was
satisfactory for most purposes. As is the way of such
things, however, soon people were coming up with
extensions. The result of this is that there is a bewildering
range of versions of HTML around.

The worst offenders are the manufacturers of browsers.
They are keen to show off the clever things that their own
browser can do and which the others can�t, so they produce
their own set of extensions to HTML. Some of these
extensions do useful things, and some of them have now
been adopted by �official� HTML. The problem with all this
is that if you use their set of extensions, you�ve got no
guarantee that someone looking at your page will be using
that particular browser. If they don�t have the right
software, they won�t see your page as you intended them to
see it, and some of the effect is lost.

�Standard� HTML is defined by the �W3 Organisation�,
which is based at the MIT in Boston, USA. If you keep to
their standards, then you�ve got a pretty good chance that
most browsers on the Internet will be able to view your
page. The most recent version is 3.2, which is the standard
which will be used for most of this book.

The two main sets of
proprietary
extensions are
produced by the two
leading producers of
commercial
browsers. Netscape
corporation were the
worst offenders in
adding extensions in
the early days of the
web. They still do it,
but fortunately most of their extensions have now become
part of the official standard. For the time being, Netscape
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�contd

Navigator is still the market leader in browsers, so if you
use Netscape extensions you�ve got a fair chance of your
pages being viewed by a large audience.

The main
competitor for
Netscape is
Microsoft�s
Internet Explorer.
Until recently,
Explorer was by
far an inferior
browser to
Netscape
Navigator: the
only real reason to
use it (besides the fact that it came free with every copy of
Windows) was that it was smaller than Netscape, so it
would run faster on a low-spec machine. Microsoft�s new
version of Explorer (version 4) is very impressive. When you
consider the number of Windows computers being sold,
there will soon be an awful lot of Internet Explorer users
out there on the Internet.

Inevitably, Microsoft have their own set of extensions to
vanilla HTML. Some of them can be simply annoying (the
way you can play a tune when you open a page is a case in
point), but some of them, such as style sheets, can be very
useful for sophisticated web design.

When you are designing a web page, you should bear in
mind that not everyone will be using your favourite
browser, and the page should still be at least partly
meaningful for them. Remember also, that not everyone
will be using the latest version of the relevant software, and
that not all features are available on all versions of a
browser. The Windows 3.1 version of a browser will
generally not have all the features of the Windows 95/
Windows NT version, and the Mac version will be different
again.

Internet
Explorer
often turns
up on

magazine cover
CDs. If you can�t
find it, you can
download it from
http://www.
microsoft.com/ie.
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HTML, HEAD and BODY tags
Officially, all the text of an HTML document should be
contained between an <HTML> tag and a </HTML> tag.
These are to identify the document as being in HTML,
rather than in some other type of SGML. In reality, most
browsers don�t particularly care about these tags and a lot
of people leave them out; but we want to do things
correctly,  right?

The <HEAD> section
Within the <HTML> tags, the next element is the
document head. Every HTML document should have a
head, but in practice again you can get away without one in
some
circumstances.
The Head
section comes
between a
<HEAD> and
a </HEAD>
tag.

The Head
section
contains
information
about the
document as a whole. There are some special tags which
should be used in the Head section:

<TITLE>
Text between a <TITLE> and a </TITLE> tag is supplied to
the browser as the title of the document. Most browsers
display this at the top of the window, and also use the title
of the document in Bookmark and history lists. For full
conformance, every HTML document should have a title
definition.

Because the title of a page may turn up in a bookmark list
weeks after someone has visited it, choose something
which will identify your document globally � that is, in

<HTML>
<HEAD>
<TITLE>Title of the document</TITLE>
</HEAD>
<BODY>

�
Body of the document
</BODY>
</HTML>
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�contd

terms of the whole Internet. A title like �Introduction� will
mean nothing if someone finds it in their bookmark list;
�Such-and-such web page: Introduction� will be clearer.

<BASE>
When you are writing your web page, it is a good idea to
specify the location of images and links using relative
addresses, rather than fully qualified addresses. This is fine
normally, but it means that if someone takes a copy of your
HTML document for local use, then the links won�t work.
You can solve this by putting a BASE tag in the head
section of the document.

A BASE tag should have one attribute, called �HREF�
(that�s short for �HyperText Reference�: we�ll see it a lot
when we come to anchor tags). The value of the HREF
attribute must be an absolute URL. The browser will put
this URL on the beginning of every relative URL in the
document.

There are a couple of other tags allowed in the HEAD
section, but they have pretty esoteric uses, so these will be
described as and when we need them.

You should never put text in the Head section � it won�t be
displayed.

The <BODY> section
The bulk of an HTML document is found in the Body
section. A few sorts of HTML document do not have a Body
section � if you�re using frames, for example � but most
do. The Body section begins with a �<BODY>� tag, and
ends with a �</BODY>� tag.

The BODY tag can have a number of attributes which allow
you to specify a background image or background and
foreground colours. These attributes were originally
Netscape extensions to HTML, though they have now been
included in HTML 3.2. Most browsers can now handle
them, but you will find the odd one which can�t. Be very
careful about your choices of colours � it�s very easy to

The
meanings
of the
terms

relative and fully
qualified addresses
are explained on
page 47.
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HTML was
written by
Americans
� so don�t

try to spell �color�
with a �u�.

make your page totally unreadable this way (especially,
remember that not everyone has the same number of
colours on their machine as you do). The attributes are as
follows:

BACKGROUND
The BACKGROUND attribute specifies an image file
(usually a .GIF file), which will be used as the background.
Its value should be the URL of the file. The file will be
repeated as necessary to fill the background (rather like a
windows wallpaper file). It�s important to make an image
file as small as possible, because if you use a large file as a
background your page will appear to be very slow to
download.

BGCOLOR
This attribute specifies the colour to use for the
background. This can be specified in one of two ways, one
easy, one more complicated. The simpler way is to use one
of the permitted colour names: aqua, black, blue, fuchsia,
gray, green, lime, maroon, navy, olive, purple, red, silver,
teal, white or yellow. If you want more control, you should
specify the colour in what�s called �RGB� notation. This is
covered on the following two pages.

TEXT
This attribute defines the colour you want your text.

LINK
This defines the colour in which to display HyperText links
which have not yet been visited.

VLINK
This defines the colour for links which have previously
been visited.

ALINK
This defines the colour of the link as you actually click it
with the mouse.

�contd
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Describing colours in RGB notation
�RGB� stands for �Red-Green-Blue�, and refers to the way
that your computer handles colours.

Computers produce a colour display by combining the
three additive primary colours � red, green and blue � in
proportions. So a bright red would be 100% red and 0%
blue and green. White is 100% of red, blue and green. Pale
green would be 100% green, 90% red and blue � oh, and
black is 0% of all three. Computers store colours as a series
of three numbers � one for red, one for blue and one for
green. To make things even more complicated, the
numbers are written in hexadecimal notation � that�s �base
16� if you remember your GCSE Maths.

In normal (�base 10�) counting, 10 means �one ten, and 0
units� (it�s all coming back, isn�t it?). In hexadecimal, �10�
means �one 16 and 0 units� � that�s sixteen in real money.
I see what you�re asking: �so what do we do when we�ve got
an eleven?� I hear you ask (I do hear you ask, don�t I?).
Well, hexadecimal works like this:

    DecimalDecimalDecimalDecimalDecimal      Hexadecimal     Hexadecimal     Hexadecimal     Hexadecimal     Hexadecimal

1 = 1

2 = 2

3 = 3

4 = 4

5 = 5

6 = 6

7 = 7

8 = 8

9 = 9   (pretty dull so far, huh?)

10 = A   (Uh-oh...)

11 = B

12 = C

13 = D

14 = E

15 = F
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Just to make it more confusing, you can recognise a
hexadecimal number because it has a �#� in front of it. So,
�#FF� in English is �255� (work it out...), and �#00� is...
zero. Getting back to our subject, #FFFFFF is hexadecimal
RGB for white and #000000 is hex RGB for black.
#FF0000 is a really strong red, #00FF00 is a really strong
green and... well, you can work it out. If you search really
hard there are RGB colour charts available on the Net.

RGB notation gives each colour a range between 0 and 255.
In binary notation, this takes up 8 bits (binary digits). With
eight bits for each of the three binary colours, that makes
24 bits of colour information. A �24 bit� display card is
able to display this many colours all at once � but let�s face
it, not everyone has a 24 bit display card. Most lesser cards
can choose from a palette of this many colours, but can
only display a limited number of them � an 8 bit card can
only display 256 at a time. Old VGA adapters can only
display 16 colours at once, and have a much more limited
palette. This is important to remember when choosing
colours, because if the display can�t produce the colour you
ask for, it will do the best it can to choose one near to it.
This, unfortunately, often totally destroys your carefully-
chosen colour scheme.

In general, when choosing colours for a web page, you�re
fairly safe if you assume that most people on the Internet
have a machine which can display 256 colours. Images will
take up some of these values, though. The safest route is to
choose from only five hexadecimal values for your colours:
00, 40, 80, c0 and ff. This gives you a choice of 125
possible colours and most machines will be able to handle
them.

�contd
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Headings
Headings divide your body text into sections. There are six
types of headings in the HTML specification. H1 is the
most important, then come H2, H3 and so on down to H6,
which is the least important.

One thing you should remember is that the HTML standard
does not specify the actual appearance of any particular
heading style � that�s up to the browser, and in some
browsers the user can apply their specifications for how a
particular style is rendered. In particular, it�s poor style to
use a header style to produce bolder or more prominent
text � it will usually work, but you can never guarantee it,
and that�s not what headers are for.

In practice it�s difficult to keep to it, but in theory you should
try and go up and down heading styles one at a time: so a 1-
Heading would contain a few 2-Headings, each of which
would contain a couple of 3-Headings, which in turn
contains 4-Headings, and so on. Headings look like this:

<H1>A 1-Heading</H1>

Start tag End tagHeading text

Your start and end tags must agree: so if the start tag is
<H1> and the end tag is </H2> your code will go wrong.
This is a surprisingly easy mistake to make, so be careful.

One very effective way of creating eye-catching text is to
use the MARQUEE tag. This scrolls text across the page,
just like the �Scrolling Marquee� screensaver that is
shipped with Windows. To do this, simply place some text
between a <MARQUEE> and a </MARQUEE> tag. There
are many attributes that can be used with this tag, but you
should be able to achieve good effects using many of the
attributes you would apply to images, like ALIGN, WIDTH,
HEIGHT, etc., to control the properties of the box through
which the text scrolls.

The
browser
will
separate a

header from the
text around it
automatically � you
don�t have to put in
extra space
yourself.

Marquee text

This only
currently
works with
Internet

Explorer.
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Paragraphs
The <P> tag designates a paragraph. There is some
confusion as to exactly how the paragraph tag should be
used. One method is like this:

<P>This is a paragraph...

Notice that the <P> tag goes at the start of the paragraph.
Another method treats the tag as a container:

<P>This is another paragraph. Note how it�s contained within

start and end tags.</P>

The third method considers the <P> tag to make the break
between paragraphs:

This is yet another paragraph.<P>

All three methods will work, though they produce subtly
different effects. Use whichever style you�re happy with.

The browser will lay out a paragraph as a continuous block
of text. Any carriage returns or tabs that you place in the
text will be ignored.

If you use the <P>-first method, some browsers will allow
you to include an ALIGN attribute. <P ALIGN=LEFT> is
the normal setup, where the paragraph is aligned to the
left; ALIGN=RIGHT makes your paragraph right-aligned
(not justified, right-aligned), and ALIGN=CENTER will
centre the paragraph.

Line breaks
The <BR> tag forces a line break. In normal text, this just
inserts a carriage return. If you use a BR with the CLEAR
attribute, it forces a move down to clear floating images.
<BR CLEAR=LEFT> moves past floating images to the left,
CLEAR=RIGHT does the same with images to the right,
and CLEAR=ALL moves clear of all floating images.
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Font styles
These tags affect the way that text is displayed. All of them
need both a start and an end tag, and affect the text within
the two tags, like this: <B>Bold Text</B>. The tags must be
nested � that is: <B>Bold <I>or</B> Italic</I> is wrong,
though <B>Bold <I>or Italic</I></B> works.

The tags are as follows:

<B> BoldBoldBoldBoldBold text

<I> Italic text

<U> Underlined text

<TT> Puts the text in a monospaced font (it stands for
�Teletype�)

<STRIKE> Strikethrough text

<BIG> Puts text in a bigger font

<SMALL> Puts text in a smaller font

<SUB> Subscripts the text (moves it down)

<SUP> Superscripts the text (moves it up)

There is also a group of these tags which describe the effect
required, and leave the exact rendering to the browser:

<EM> Emphasised text, usually rendered italic

<STRONG> Strong text, usually rendered bold

<DFN> Used for the definitions

<CODE> Used for extracts of program code

<SAMP> Used for sample output from a program

<KBD> Used for text typed by a user (on the
keyboard)

<VAR> Used for variables in program functions

<CITE> Used for citations and references
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Font sizes
The FONT tag allows you to change the size or colour of
the current font. HTML defines seven font sizes: font size
1 is the smallest, 7 is the largest.

The FONT tag is a container � that is, you must have a
</FONT> tag at the end of the section it effects. The tag
has these attributes:

SIZE
This sets the new font size (obviously). There are two ways
you can use this attribute. You can specify an absolute size
for the font, <FONT SIZE=6> for example. Otherwise you
can specify the font size relative to the current BASEFONT
setting. See the section below for details of BASEFONT. A
relative font size is expressed like this:

<FONT SIZE="+3"> or

<FONT SIZE="-2">

The actual font size can never be smaller than 1 or bigger
than 7.

COLOR
This specifies the colour of the font. It has the same
possible values as the BACKGROUND attribute of the
BODY tag.

The BASEFONT tag
The BASEFONT tag defines the font size that relative font
sizes are worked out from. There is no end tag � you just
need a single tag. The tag has one attribute, SIZE which
you have to include (because otherwise the tag wouldn�t do
anything at all).

If you don�t have a BASEFONT tag, the basefont size for
the document is considered to be 3.
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Other layout tags
There are a number of other HTML tags which affect the
way that text is laid out. All of these tags are containers �
that is, they affect the text between the start and end tags.

<PRE> � preformatted text
Normally, a web browser will lay out the text in an HTML
document so that it fits neatly in the browser�s window.
Any ends of lines, extra spaces, tabs etc. which you include
will be replaced by a single space. Most of the time this is a
good idea � as with a word processor, you don�t need to
worry where lines end. In some cases, for example if you
are laying out a poem, you actually want the carriage
returns left as you made them. In this case you should
enclose the text in <PRE> tags.

Text in a PRE tag is displayed in a fixed font � that is, a
font in which all letters are the same width, as against a
proportionally-spaced font, where an �i� is much narrower
than an �m�. A fixed font makes it much easier to line up
columns made up of spaces and such like.

<PRE>

�The time has come� the Walrus said,

 �To talk of many things:

Of shoes-and ships � and sealing-wax -

 Of cabbages � and kings -

And why the sea is boil ing hot -

 And whether pigs have wings.�

</PRE>

This HTML code...

...will look

like this in

Netscape

Navigator
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Within a PRE tag you should be careful about which HTML
tags you use. Those which change the size or appearance of
the text (like FONT tags) will not work.

DIV and CENTER
The DIV Tag is part of HTML 3.0, so not all browsers will
handle it. A DIV tag is used to designate a �division� of the
text. The DIV tag has one attribute: ALIGN. Text within
<DIV ALIGN=LEFT> will be left-aligned, like normal text.
ALIGN=RIGHT will be aligned to the right margin, and
ALIGN=CENTER will produce centred text.

The CENTER tag does exactly the same as
<DIV ALIGN=CENTER>, and is an earlier bit of HTML
which has been retained because it is so common on the
web.

BLOCKQUOTE
Text contained within a BLOCKQUOTE tag is formatted as
a separate paragraph, and most browsers display it
indented.

ADDRESS
Text contained in an ADDRESS tag should contain
information identifying the author of the page in question.
Use an ADDRESS tag to put in your name, eMail address,
home page location, even your (street) address if you�re
brave enough.

The ADDRESS tag is usually displayed in italic text. You
can put other tags in an ADDRESS tag, like <EM> tags, or
anchors to other pages etc.

�contd

HTML
uses
American
spellings,

so it�s �CENTER�,
not �CENTRE�.
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Lists
HTML has a number of tags to describe different types of
lists of things. All lists have the same basic syntax: the
difference is the way they are displayed. You can have lists
within lists: this is useful for tables of contents, and such
like.

Unordered lists
The simplest type of list is an unordered list. The elements
of an unordered list are usually displayed as a series of
bullet points.

An unordered list is contained between <UL> and </UL>
tags. Each element in the list should be started by an <LI>
tag.

<UL>

<LI>Element 1

<LI>Element 2

<LI>Element 3

<UL>

<LI> Element 3.1

<LI> Element 3.2

</UL>

</UL>

This fragment of HTML shows

an unordered l ist

Each element of the l ist is

marked by a <LI> tag

This section shows a l ist

within a l ist � it will be

displayed differently

This is what the section

above wil l look l ike in

Netscape Navigator
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Ordered lists
An ordered list is just like an unordered list, but the
elements are displayed numbered. The browser will work
out the numbering scheme for you.

<OL>

<LI>Element 1

<LI>Element 2

<LI>Element 3

<OL>

<LI> Element 3.1

<LI> Element 3.2

</OL>

</OL>

This HTML wil l look

like this in Netscape

Navigator. Note that

ordered lists don�t

cope with sublists as

well as unordered l ists

DIR and MENU
These two list styles are intended for directory listings and
for menus of options respectively. They are supposed to be
more compact than normal lists, but Netscape Navigator at
least displays them just like a UL.
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Hyperlinks
The important bit about HTML is of course the ability to
put in HyperText links. This is done using the A (for
�Anchor�) tag.

An Anchor tag looks like this:

<A HREF=somewhere>The Anchor</A>

The �HyperText

Reference� attribute

defines the URL of the

destination of the anchor

The section between the <A>

and the </A> is the body of the

anchor: this is the bit which will

be underlined by the browser

In general, you can put anything you like in the body of the
anchor. One trick is to put an <IMG> anchor there: that
will make the image into a button.

The Anchor tag has the following attributes:

HREF
The value of this attribute gives the location which the link
points to. Normally, this is the URL of the page which you
wish to go to when the anchor is clicked on. If the page is
on the same server, then you don�t have to write in the
complete URL of the page. This is called a �relative� URL,
and in this case the base address of the current page (the
site name and directory) is added on to the filename you
provide. It�s often a good idea to use relative URLs, because
it means that it doesn�t matter where exactly the pages are
finally placed, they will still work. However, if you always
use full URLs, then someone can save your page to their
local disk, and it will still work OK.

You can point an anchor to a place other than the top of a
file. If you specify �HREF=somefile.htm#somewhere�, the
browser will fetch the file �somefile.htm�, and display it so
that the anchor named �somewhere� is at the top of the
window. If you use �HREF=#somwhereelse� the browser
will go to the anchor named �somewhereelse� in the
current document.

You�ll
sometimes
see
someone

talking about a
�fully qualified�
URL. This just
means the complete
URL.
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The HREF of an anchor doesn�t have to be another HTML
file (though it often is). You can point an anchor at any
sort of file, as long as it�s on the server. If the file is not
HTML, the browser will download it. What it does with the
file when it�s got it depends on the type of the file � and
more particularly, on its type designation (the bit of the file
name after the �.�). A file which ends with �.html� or
�.htm� will be assumed to be HTML, and the browser will
try to display it, even if it isn�t really HTML (it�s hard to see
why you would have another type of file ending in .htm,
but you never know). A text file (ending in �.txt�) will be
displayed as plain text by the browser. A GIF or JPEG
image will usually be displayed on its own by the browser.
This can be useful if you�ve got a big image file that you
want people to be able to get at, but you want the page to
download quickly: make a small �thumbnail� of the image,
and make it an anchor to the full-screen version.

What happens to other types of files depends on whether
the browser has a �helper application� defined for the
particular type. If there is a helper defined, then that
application is run; if not, the file is saved to hard disk. This
makes it easy to make archives of software etc. available on
the web.

TITLE
If you specify a TITLE attribute, this text is displayed on
the bottom line of the browser if you point to the anchor
with the mouse, but don�t click on it.

NAME
If you specify a NAME attribute, then that anchor can be
specified as the destination of another anchor. For
example, if you put <A NAME=index> into a document,
then you can point to that part of your document like this:
<A HREF=#index>. A named anchor can itself point to
somewhere else (that is, it also has an HREF attribute), or
you can stop it from showing up on a page by immediately
following it by a </A> tag, like this:

<A NAME=end></A>

HTML files
should end
with
�.html�;

however, DOS only
allows 3-character
file extensions, so
you can use �.htm�
too.
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Horizontal rules
The <HR> tag ends a paragraph, and inserts a horizontal
line across the screen. It has the following attributes:

ALIGN
The ALIGN attribute can have the value of LEFT, RIGHT
or CENTER. It gives the vertical alignment of the rule.
Note that unless the WIDTH attribute is changed, this has
no effect.

NOSHADE
Normally, the line of an HR is shaded, so that it looks like
this:   .  If you do <HR NOSHADE>, it comes out
looking like this:

SIZE
This attribute describes the thickness of the line, in pixels.

WIDTH
The WIDTH attribute tells the browser how long the line of
an HR should be. You can express it in two ways. If you
use <HR WIDTH=75>, it tells the browser that the line
should be 75 pixels long (regardless of how wide the screen
is). On the other hand, <HR WIDTH=�75%�> will make the
line 75% of the current width of the screen.

Basic HTML � an example
Many of the
concepts covered
in this chapter are
applied in the
example below,
which uses a
simplified version
of a page from
Computer Step�s
web site. Compare
the screenshot with
the HTML code
that follows.

It�s very
easy to get
carried
away with

using <HR>s. Use
them sparingly for
best results.
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<html>
<head><tit le>Computer Step</tit le></head>
<body bgcolor="#fff f f f ">

<img src="187402958x.gif" al ign="left"
hspace="10">
<br>
<b>Title:</b>    Internet Explorer in easy
steps<p>
<b>Author:</b>    Mary Lojkine<p>
<b>ISBN:</b>    1-874029-58-X<p>
<b>Covers Versions:</b>    up to v.3<p>
<b>Price:</b>    £7.50<p>
<b>Publicat ion:</b>    1996<p>
<b>No. of Pages:</b>    160

<br clear=left>

<hr size=2 al ign=center width=100% noshade>
<br><h2 al ign="left">Contents:</h2>

1.  Getting Started<br>
13. Newsgroups<br>
Index

<hr size=2 al ign=center width=100% noshade>

</body>
</html>

Opens the HTML
document
Sets background
colour to white
Places image,
aligned left
Line break

Displays text, with
headings in bold,
and with a
paragraph break at
the end of each line

�Clear� line break
makes what follows
appear below image
Horizontal line
�Contents� heading

Lists contents (most
entries have been
omitted, to save
space)
Horizontal line

Closes body and
HTML

Certain aspects of this web page would be presented better
if we were to organise the information here using methods
that have not yet been covered. In particular, the graphics
and text could be aligned more effectively by using a table.
Chapter Six covers the use of tables to hold text and other
objects.
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